Page 22 of 15
Project 1: Creating a Worksheet and an Embedded Chart

Microsoft Office 2013 Illustrated

Instructor’s Manual
Page 1 of 17

Microsoft Office 2013 Illustrated
Windows 8 Unit B: Understanding File Management

A Guide to this Instructor’s Manual:

We have designed this Instructor’s Manual to supplement and enhance your teaching experience through classroom activities and a cohesive chapter summary.  
This document is organized chronologically, using the same heading in dark blue that you see in the textbook.  Under each heading you will find (in order): Lecture Notes that summarize the section, Figures and Boxes found in the section, if any, Teacher Tips, Classroom Activities, and Lab Activities.  Pay special attention to teaching tips, and activities geared towards quizzing your students, enhancing their critical thinking skills, and encouraging experimentation within the software. 

In addition to this Instructor’s Manual, our Instructor’s Resources CD also contains PowerPoint Presentations, Test Banks, and other supplements to aid in your teaching experience. 
For your students: 

Our latest online feature, CourseCasts, is a library of weekly podcasts designed to keep your students up to date with the latest in technology news.  Direct your students to http://coursecasts.course.com, where they can download the most recent CourseCast onto their mp3 player. Ken Baldauf, host of CourseCasts, is a faculty member of the Florida State University Computer Science Department where he is responsible for teaching technology classes to thousands of FSU students each year. Ken is an expert in the latest technology and sorts through and aggregates the most pertinent news and information for CourseCasts so your students can spend their time enjoying technology, rather than trying to figure it out. Open or close your lecture with a discussion based on the latest CourseCast.
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Unit Objectives
Students will have mastered the material in Windows 8 Unit B when they can:

· Understand folders and files
· Create and save a file
· Explore the files and folders on your computer
· Change file and folder views
· Open, edit, and save files
· Copy files
· Move and rename files
· Search for files, folders, and programs
· Delete and restore files
Windows 26:  Understand Folders and Files
LEARNING OUTCOMES

· Analyze a file hierarchy

· Examine files and folders

LECTURE NOTES
· Start off by reviewing the concept of a drive and the importance of the hard disk drive. Then explain and illustrate the difference between the terms “folder” and “file.” You can use a real-life file folder with paper documents to explain that in an office your supervisor might ask you to locate a client’s file, but what he or she means is for you to find the folder (or hanging folder) that contains the paper documents for that client. Then note that a folder on a computer is comparable to a paper folder (or hanging folder) in a filing cabinet, and that a file on a computer is comparable to a paper document in a folder (or hanging folder) in a filing cabinet. You might want to use that time-honored tradition of comparing different drives on a computer to different drawers in a filing cabinet. Then you can extend this analogy by describing the concept and use of subfolders within folders, and compare subfolders to multiple folders within a hanging folder in a filing cabinet. 
· You can use FIGURES B-1 and B-2, on page Windows 27, to illustrate how students might organize their personal folders and files on a hard disk drive.  Explain the types of default user folders provided by Windows 8.
· Discuss file addresses and demonstrate how to navigate File Explorer using the Address bar, the File list, and the Navigation pane.
· Briefly describe the basic operations you can perform with folders and files; namely, copying, moving, renaming, locating, deleting, restoring. Note that subsequent lessons touch on each of these topics in more detail.
· Conclude by pointing out that managing folders and files on a computer is one of the most important tasks faced by users. Good file management skills are essential for using a computer and for taking other classes offered by your department.
FIGURES: B-1, B-2
BOXES
1. Quick Tip: The program name “File Explorer” doesn’t appear in the title bar. Instead, you’ll see the current folder name.
2. Quick Tip: Remember that in the Address bar you single-click a folder or subfolder to show its contents. But in the File list, you double-click a subfolder to open it.
3. Clues to Use: Plan your file organization

As you manage your files, you should plan how you want to organize them. First, identify the types of files you work with, such as images, music, and documents. Think about the content, such as personal, business, clients, or projects. Then think of a folder organization that will help you find them later. For example, use subfolders in the My Pictures folder to separate family photos from business photos or to group them by location or by month. In the My Documents folder, you might group personal files in one subfolder and business files in another subfolder. Then create additional subfolders to further separate sets of files. You can always move files among folders and rename folders. You should periodically reevaluate your folder structure to make sure that it continues to meet your needs.
TEACHER TIP

Some students may not find the term “file hierarchy” to be intuitive, so it might be helpful to use an organizational chart, like the one shown in FIGURE B-1, to illustrate the concept of hierarchy. Use the figure to illustrate the general organization of drives, folders, and files on a computer. Then, open the Documents window and click the Folders button at the bottom of the Navigation Pane to show the logical file hierarchy on a Windows 8 system.

CLASSROOM ACTIVITY
1. Quick Quiz:


1. T/F  A folder is a container for a group of related folders and files. (T)

2. T/F  You can only move up and down in a hierarchy by using the Navigation pane. (F)

3. T/F  Windows 8 comes with existing folders for storing different types of files. (T)
LAB ACTIVITY
Ask students to briefly describe how they would organize files that contain their term papers, lab assignments, and class reports on their hard disk drive. Then have them create a diagram of their proposed folder structure.
Here is a sample response:
I would open the My Documents folder and then create three new folders named Term Papers, Lab Assignments, and Class Reports. Then I would move the files into their appropriate folder and store future files in the appropriate folder.

[image: image1]
Windows 28:  Create and Save a File

LEARNING OUTCOMES

· Start WordPad

· Create a file

· Save a file

LECTURE NOTES
· Discuss the value of Windows 8 accessory programs and explain that WordPad is an easy-to-use, free program included with Windows 8 for creating simple documents like term papers, reports, lists, and letters. Illustrate how to locate and open WordPad using the All apps button to access the Apps screen.

· After opening WordPad, describe the components of a program window; namely, the title bar, the document window, the Quick Access toolbar, the Ribbon, the status bar, and the taskbar. Point out the similarities between WordPad and Paint, which students used in Unit A. Remind students that opening WordPad automatically opens a new, blank file.
· Step through the process for creating a simple document. Show the insertion point and how WordPad places it at the beginning of the first new line in the document and also at the beginning of a new line each time Enter is pressed.
· Explain that when a new document is created, it exists only in the computer's RAM. Note that RAM is dependent on the availability of power. If a power failure occurs, the computer is turned off, or if their computer stops responding for some reason, they can lose whatever work they’ve done on a document. This is the reason for saving a file.
· Explain that the File tab contains two options for saving a file, Save and Save As. They are identical when you save a file for the first time, both options display a Save As dialog box and let you choose where you want to save a file and what to name it. If you open a file that you’ve previously saved and make changes to the file, the Save option automatically saves the file under the same filename in the same location. The Save As option is used when you want to retain the original file as well as the revised file.
· Explain that a USB flash drive is a portable disk drive that is a popular way for storing and transporting files when working in different locations (such as home and work or home and a computer lab).  When the USB flash drive is plugged into a computer, Windows automatically detects the presence of the flash drive and assigns it a drive name, e.g., Computer>Removable Disk (E:). Tell the students the drive name used for USB flash drives on the lab computers.
· Demonstrate how to save a file to a flash drive, which is likely called (E:), and NOT to the computer's hard drive, usually (C:). If students don't have a flash drive, have them save to My Documents on the hard drive. Point out that the file extension for a WordPad document is automatically .rtf (Rich Text Format). 
· If time permits, discuss the Windows 8 Libraries, refer to FIGURE B-5 on page Windows 29.
FIGURES: B-3, B-4, B-5
BOXES
1. Trouble: If you make a typing mistake, press [Backspace] to delete the character to the left of the insertion point.

2. Quick Tip: On a laptop computer, the USB port is on the left or right side of your computer.

3. Trouble: If you don't have a USB flash drive, save the document in the My Documents folder or ask your instructor which storage location is best.
4. Trouble: If your Save As dialog box does not show the .rtf file extension, click Cancel, open File Explorer, click the View tab, then in the Show/hide group, click the File name extensions check box to select it.
CLASSROOM ACTIVITIES

1. Class Discussion: Discuss the differences between the Save and Save As commands. Discuss what will happen if students create and save a file for the first time using Save, Save As, and the Save button. Demonstrate the differences using a new document, such as saving a new resume for a job application and then a revised version of the same document. Show how to use Save As to make a copy of a file using the same filename but in a different location, or using a different filename in the same location.
2. Quick Quiz:
1. How do you know where the next character that you type will appear? (The next character you type will appear at the location of the insertion point)
2. What is .rtf and what does it mean? (It is a file extension that means Rich Text Format)
3. Where do you plug in a flash drive? (Into a USB port on the computer)
4. What happens to a file or folder that exists only in RAM when the computer is turned off? (RAM is cleared and the file or folder is lost)
Windows 30:  Explore the Files and Folders on Your Computer
LEARNING OUTCOMES

· Navigate to file storage locations

· Open folders

LECTURE NOTES
· Demonstrate how to view the various files and folders on a computer hard disk drive using the File Explorer button on the taskbar, and then clicking Computer.
· Review the term hierarchy and show how to navigate between the various levels of the hierarchy on the hard drive.

· Explain the Users folder and discuss whether it is accessible on your college's lab computers.

· Be sure to show students the My Documents level, and then show the various folders and documents they can work with.  Point out the path to the student's folder contents as shown in the Address bar.

· Use TABLE B-1 to review ways to navigate a computer’s file hierarchy.

FIGURES: B-6, B-7
TABLE: B-1
BOXES
1. Trouble: If you don’t see the colored bar, click the View tab, then click Tiles in the Layout group.
2. Trouble: If you do not have a USB flash drive, click the Documents library in the Navigation pane instead.
3. Quick Tip: In the Address bar, you can click ( to the right of a folder name to see a list of the subfolders; if the folder is open, its name appears in bold.
 CLASSROOM ACTIVITY
1. Quick Quiz:
1. T/F In a file hierarchy, you can move up one level at a time by pressing [Backspace]. (T)
2. Name four types of computer drives. (hard drive, CD drive, DVD drive, USB drive)
LAB ACTIVITY
Ask students to open their User Name folder and:

1. Use the Navigation Pane to navigate first to the My Pictures folder and then to the My Music folder. After that, ask them to use the Back button to navigate back to the My Pictures folder.
2. Use the Address Bar to navigate first to the My Videos folder and then to the Contacts folder. After that, ask them to use the Back button to navigate back to the My Videos folder.

Windows 32:  Change File and Folder Views
LEARNING OUTCOMES

· View files as large icons

· Sort files

· Preview files

LECTURE NOTES
· The Layout group on the View tab provides eight ways to display the folders and files in a window. Remind students that changing the view does not affect the content of their folders or files. Explain the views as follows:
· Extra Large Icons, Large Icons, and Medium Icons views display rows of folder and file icons at different sizes, with their names displayed under the icon.

· Small Icons view displays rows of even smaller folder and file icons with the folder or filename to the right of the icon.

· List view displays columns of very small folder or filename icons with the names to the right of the icon.

· Tiles view is similar to Small Icons view, but displays larger icons and also lists the type of folder or file and the file size.

· Details view is similar to List view, but displays columns with the folder or filename, the date and time that a folder or file was modified, the type of folder or file, the size of files, and any tags assigned to a file. A tag is a word or phrase that reminds you of a file’s content.

· Content view provides a view of the beginning content in the file.
· 
Demonstrate how the files in a folder can be sorted to change the order in which they are listed.
FIGURES: B-8, B-9, B-10, B-11
BOXES
1. Quick Tip: You can scroll up and down in the Layout group to see views that are not currently visible.
2. Quick Tip:  Clicking Favorites displays folders you use frequently; to add a folder or location to Favorites, display it in the File list, then drag it to the Favorites list.
3. Clues to Use: Snapping Windows 8 apps

If your machine has a screen resolution of 1366 x 768 or higher, you can use snapping to view two Windows 8 apps side by side. Go to the Start screen and open the first app, then return to the Start screen and open the second app. Point to the upper-left corner of the screen until you see a small square representing the first app, right-click the square, then click the Snap left or Snap right. (Or you can drag the square to the right or left side of the screen.) One app then occupies one half of the screen and the other takes up two thirds of the screen. See FIGURE B-11.
CLASSROOM ACTIVITY
1. Quick Quiz:


1. How can you preview the content of a document? (Click the Preview pane button in the Panes group on the View tab, and select the file that contains the document you want to preview.)

2. How can you find out the size of a file? (You select the file and then use the Details view to view its file size.) 

LAB ACTIVITY
Ask students to examine each of the different view options for viewing files in a folder.
Windows 34:  Open, Edit, and Save Files
LEARNING OUTCOMES

· Open a file

· Edit a file

· Save a file

LECTURE NOTES:

· Demonstrate how to open an existing WordPad file and review how to use the Open dialog box.
· Point out the current folder or drive on the Address Bar, and remind students that they can navigate with the Address Bar to locate the file they want to open.
· Note that when opening a file from a program, they must:

· First, verify and, if necessary, select the drive where the file is currently stored.
· Second, verify that they are viewing the contents of the folder that contains the file they want to open and, if that’s not the case, locate and open the folder where the file is currently stored.
· Third, select the file they want to open by clicking the file.
· Finally, click the Open button in the Open dialog box.
Note: You might also want to point out that they can double-click the file they want to open and then they don’t have to click the Open button.
Note: If the computers at your college use single-click activation instead of Classic style, then a single-click opens the file. If this is the case, remind your students.
· Demonstrate how to open a previously-created WordPad document and edit that document by adding text at the end of the document. Discuss other common editing techniques, such as:

· Positioning the insertion point in the text to insert more text or make a change
· Using the Delete and Backspace keys
· Demonstrate how to save a previously-saved document with the Save button, and remind students that Windows saves the document in the same location under the same filename. Remind students this means that the document with the changes that they just made replaces the previous copy of that document. Point out that if they want to preserve the original copy of a file, they should use the Save As command instead.
· Review the Save and Save As commands and when to use each.
FIGURES: B-12, B-13, B-14
BOXES

1. Quick Tip: You can also press the Windows key to switch between the Start screen and the desktop. However, if you have a Windows 8 app open, it’s best to click the Desktop tile on the Start screen. 
2. Quick Tip: You can also double-click the filename in the File list to open the file.
3. Quick Tip: To save a changes to a file, you can also click the Save button on the Quick Access toolbar (on the left side of the title bar).

4. Clues to Use: Comparing Save and Save As

The WordPad menu has two save command options—Save and Save As. The first time you save a file, the Save As dialog box opens (whether you choose Save or Save As). Here you can select the drive and folder where you want to save the file and enter its filename. If you edit a previously saved file, you can save the file to the same location with the same filename using the Save command. The Save command updates the stored file using the same location and filename without opening the Save As dialog box. In some situations, you might want to save a copy of the existing document using a different filename or in a different storage location. To do this, open the document, use the Save As command on the File tab, navigate to the location where you want to save the copy if necessary, and/or edit the name of the file.
5. Clues to Use: Using Cloud Storage

Many users store their files on special file storage locations on the World Wide Web, knows as cloud storage locations. Examples of cloud storage locations include Microsoft SkyDrive and DropBox. By storing files in the cloud, your files are automatically updated when you make changes to them on your computer, and you can access them from different devices, including laptops, tablets, and smartphones. Microsoft Office programs such as Word and Excel show SkyDrive as a storage location when you open or save a file, making cloud storage a convenient option.
CLASSROOM ACTIVITIES
1. Quick Quiz:
1. List the steps you follow to open a WordPad file.
Here is a sample response:

a.
Open WordPad and then choose Open from the File tab.
b.
In the Open dialog box verify and, if necessary, select the drive where the file is currently stored.
c.
Verify that you are viewing the contents of the folder that contains the file you want to open and, if that’s not the case, locate and open the folder where the file is currently stored.
d.
Select the file you want to open by clicking the file.
e.
Click the Open button in the Open dialog box.
Note: Some students might combine the last two steps by double-clicking the file to open it.
2. Class Discussion: Suppose you want to revise an existing resume you have on your hard drive. You want it to be more specific in some areas in response to a job opportunity, yet you want to keep the current resume as it is for other uses. Ask students to tell you:
· What Save function to use (Use Save As, not Save)

· Two ways to differentiate between the two resumes:

· Use Save As and store the file in different storage location

· Use Save As and change the name of the second file

Windows 36:  Copy Files
LEARNING OUTCOMES

· Create a new folder

· Copy and Paste a file

LECTURE NOTES

· Show students how to create a backup copy of a file on a USB flash drives. If a student doesn't have a flash drive, have the student create the backup copy in his or her student folder on the computer's hard drive.
· Demonstrate these methods of copying a file: Selecting the file, then clicking the Copy button in the Clipboard group on the Home tab on the Ribbon; right-clicking the file in the file list, then clicking Copy; and right-clicking the file, then holding down [Ctrl] and pressing [C].
· Discuss the clipboard and emphasize that copied material remains on the clipboard until something else is copied or the Windows session is ended.

· Demonstrate the following two methods of pasting a file: Navigate to the the location where you want to paste the file, then clicking the Paste button in the Clipboard on the Home tab on the Ribbon; or use the keyboard by holding down [Ctrl] and pressing [V].
· Show students the alternate method of copying files to their USB drives by using Send to commands.

· Use TABLE B-2 to discuss options on the Send To menu. For example, the Compressed (zipped) Folder option on the Send To menu creates a new compressed (smaller) file using the same filename, but with the .zip file extension. For example, compressing To-Do List.rtf creates a new file named To-Do List.zip. The “Desktop (create shortcut)” option on the Send To menu creates a shortcut (link) to the file on the desktop. The Mail recipient option creates an e-mail with the file attached to it, but only if you have an e-mail program on the computer.
FIGURES: B-15, B-16
TABLE: B-2
BOXES

1. Quick Tip: You can also create a new folder by clicking the New Folder button the Quick Access toolbar (on the left side of the title bar).

2. Quick Tip: You can also copy a file by right-clicking the file in the File list and then clicking Copy, or you can use the keyboard by pressing and holding [Ctrl] and pressing [C], then releasing both keys.
3. Quick Tip: To paste using the keyboard, press and hold [Ctrl] and press [V], then release both keys.

4. Clues to Use: Copying files using Send to

You can also copy and paste a file using the Send to command. In File Explorer, right-click the file you want to copy, point to Send to, then in the shortcut menu, click the name of the device where you want to send a copy of the file. This leaves the original file on your hard drive and creates a copy on the external device. You can send a file to a compressed file, the desktop, a mail recipient, your Documents library, or a drive on your computer. See TABLE B-2.

CLASSROOM ACTIVITIES
1. Quick Quiz: 

1. Where is the clipboard information stored on the computer? (In the computer's RAM)
2. What are two reasons you might want to copy a file? (To make a backup copy; to open the file on another machine)
3. When you copy and paste a file, what happens to the original file? (It remains in its original location)
4. Is it possible to have two copies of a file with the same name in the same folder? (No)

2. Critical Thinking and Class Discussion: Have the students compare the methods presented in lecture for copying a file and then discuss which methods seem easiest or most appropriate in certain situations.
Windows 38:  Move and Rename Files
LEARNING OUTCOMES

· Cut and paste a file

· Rename a file

LECTURE NOTES
· Demonstrate and describe what happens when you move a file. Emphasize that moving changes the location where a file is stored. Unlike copying, you will have only one copy of the file that you move, but it will be in a new location. 
· Note that there are different techniques for moving files, including drag and drop. Point out that (in most cases) Windows physically moves a file when they drag and drop it onto another folder on the same drive. If they drag and drop a file to another drive, then Windows copies the file instead. Also note that using drag and drop is a lot easier if you change the window view to Large Icons view.
· Illustrate the use of the Cut and Paste buttons in the Clipboard group on the Ribbon.

· Show an alternate method to cut a file by right-clicking a file, then holding [Ctrl] and pressing [X].

· Review an alternate method to paste a file by right-clicking a file, then holding [Ctrl] and pressing [V].
· Show the students how to rename a file and discuss when they might need to do this.
· Emphasize that if students decide to rename a file, they should not change the file extension, but only change the original filename. Explain to students that if they change or delete the file extension, then Windows may not know what program to open the file with or the file won't open at all.
FIGURES: B-17, B-18, B-19, B-20
BOXES
1. Quick Tip: You can also cut a file by right-clicking the file in the File list and then clicking Cut; or by clicking it, pressing and holding [Ctrl] and pressing [X], then releasing both keys.
2. Quick Tip: You can also paste a file by right-clicking an empty area in the File list and then clicking Paste, or by pressing and holding [Ctrl] and pressing [V], then releasing both keys.
3. Clues to Use: Using Windows 8 libraries

The Navigation pane contains not only files and folders, but also libraries. A library gathers file and folder locations from different locations on your computer and displays them in one location. For example, you might have pictures in several different folders on your storage devices. You can add these folder locations to your Pictures library. Then when you want to see all your pictures, you open your Pictures library instead of several different folders. The picture files stay in their original locations, but their names appear in the Pictures library. A library is not a folder that stores files, but rather a way of viewing similar types of documents that you have stored in multiple locations on your computer. FIGURE B-20 shows the four libraries that come with Windows 8: Documents, Music, Pictures, and Videos. To help you distinguish between library locations and actual folder locations, library names differ from actual folder names. For example, the My Documents folder is on your hard drive, but the library name is Documents. If you save a document to the Documents library, it is automatically saved to your My Documents folder.

CLASSROOM ACTIVITY
1. Quick Quiz:
1. T/F  When you rename a file, Windows changes both the filename and file extension.  (F)
2. T/F  If you create a new folder named “New Folder”, you cannot change its name.  (F)
3. T/F  When you move a file, the file stays in its original location and a copy of the file is moved to the new location.  (F)
4. T/F  If you drag and drop a file to a folder on another drive, Windows copies the file. (T)

5. T/F  If you drag and drop a file to a folder on the same drive, Windows does not copy the file. (T)

LAB ACTIVITIES
1. Have students practice moving a file from one folder to another and then one drive to another using one of the cut and paste methods presented in the lesson.

2. Ask students to practice dragging and dropping to copy and move a file.
Windows 40:  Search for Files, Folders, and Programs
LEARNING OUTCOMES

· Search for a file

· Open a found file

LECTURE NOTES
· To illustrate the Search feature, you might want to walk students through the steps they will complete in this lesson, and also illustrate some variations on those steps. For example, illustrate the Search results that Windows produces for each of the following variations on the same type of search to locate the file New Tours List.rtf:

· New
· New Tours
· New Tours List

· New Tours List.rtf

· List

· Discuss the different types of search criteria that students might use to locate a file and describe the advantages and in some cases, the disadvantages, of each approach. Point out that the more specific they are in specifying their search criteria, the more likely they will find what they are searching for. Also, their search results will not include as many files that meet the search criteria.

· Point out that searches are not case sensitive.

· More advanced searches can be performed using the:

· File extension

· Name/part of the name of the person who created the file

· Date created

· Document title

· Name of an e-mail contact

FIGURES: B-21, B-22, B-23, B-24
BOXES

1. Quick Tip: To immediately open File search in the Search charm, press the Window key and [F] together.
2. Quick Tip: If you navigated to a specific folder in your file hierarchy, Windows would search that folder and any subfolders below it.
3. Quick Tip: Windows search is not case-sensitive, meaning that you can type upper-case or lowercase letters when you search, and obtain the same results.
4. Clues to Use: Using the Search Tools tab in File Explorer
The Search Tools tab appears in the Ribbon as soon as you click the Search text box, and it lets you narrow your search criteria. Use the commands in the location group to specify particular search location. The Refine group lets you limit the search to files modified after a certain date, or to files of a particular kind, size, type or other property. The Options group lets you repeat previous searches, save searches, and open the folder containing a found file. See FIGURE B-24.

CLASSROOM ACTIVITIES
1. Classroom Discussion and Critical Thinking: Ask students what type of Search results Windows might display if they did a search using the word “tour.”
Students should respond with the first two responses, and might even include the second two responses:
· One or more folders with the word “tour” in the folder name
· One or more files with the word “tour” in the filename

· One or more desktop shortcuts with the word “tour” in the filename

· One or more files that contain the word “tour” in the contents of the file
2. Quick Quiz:
What are search criteria? Give an example.

Here is a sample response:


Search criteria consist of one or more pieces of information that help Windows identify the file you want to locate. For example, you might enter the search criteria “hot air balloons” if you were trying to locate a file that contained a term paper on hot air balloons.
LAB ACTIVITIES
1. Ask students to use the Windows Search feature to locate and open:

· Calculator (a Windows accessory program)
· The My Documents folder
2. Ask students to use the following search criteria with the Windows Search feature and then examine the results Windows displays.

· folder

· picture
· document
Windows 42:  Delete and Restore Files
LEARNING OUTCOMES

· Delete a file

· Restore a file

· Empty the Recycle Bin

LECTURE NOTES
· Explain the purpose of the Recycle Bin and how it works. Note that the Recycle Bin only holds folders or files that are deleted from a hard disk drive. If you delete a folder or file by mistake, or if you change your mind after deleting a folder or file, you can open the Recycle Bin and restore the folder or file (assuming you have not already emptied the Recycle Bin). If you empty the Recycle Bin, you cannot recover or restore a folder or file with Windows.

· Demonstrate how to delete a file using the Delete button in the Organize group on the Library Tools Manage tab, how to open the Recycle Bin, and how to restore a file from the Recycle Bin. Then demonstrate the same features by deleting a folder with its files. Before deleting the folder, open it and show your class that the folder contains a set of files, all of which Windows deletes when you delete the folder. Point out that when Windows restores a file or a folder, it puts it in its original location on the hard disk, and, in the case of folders, will rebuild the folder structure and restore the folder’s contents.
· Delete a file that you no longer need and then demonstrate how to empty the Recycle Bin. Point out that this operation is irreversible, but that it is important to periodically use it in order to free up valuable storage space on a hard disk.
· Emphasize that if you delete a folder or file from a removable disk, such as a USB flash drive, then the folder or file is permanently deleted and you cannot recover it with Windows.

· You can select more than one file or folder to delete, cut, or copy all at once. If the items are next to each other in a window, click the first item and hold down [Shift] while clicking the last item. The first, last, and all items between them are selected. If the files or folders are not adjacent to each other, click the first item, hold down [Ctrl], then click the other items. Then you can delete, copy, or cut the group of files or folders selected.

FIGURES: B-25, B-26, B-27
BOXES
1. Quick Tip: The Library Tools Manage tab becomes available on the Ribbon whenever a library location is open. You can use it to change the locations the Library represents, as well as other related options.

2. Quick Tip: If the Recycle Bin icon does not contain crumpled paper, then it is empty.
3. Quick Tip: Another way to delete a file completely is to select the file, press and hold [Shift], then press [Delete]; if you click Yes in the message box that opens, Windows 8 deletes the file without sending it to the Recycle Bin. Use caution, however, because you cannot restore the file.
4. Clues to Use: More techniques for selecting and moving files

To select a group of times that are next to each other in a window, click the first time in the group, press and hold {Shift], then click the last item in the group. Both items you click and all the items between them become selected. To select files that are not next to each other, click the first file, press and hold [Ctrl], then click the other items you want to select as a group. Then you can copy, cut, or delete the group of files or folders you selected. Drag and drop is a technique in which you use your pointing device to drag a file or folder into a different folder and then drop it, or let go of the mouse button, to place it in that folder. Using drag and drop does not copy your file to the clipboard. If you drag and drop a file to a folder on another drive, Windows 8 copies the file. However, if you drag and drop a file to a folder on the same drive, Windows 8 moves the file into that folder instead. See FIGURE B-27.  If you want to move a file to another drive, hold down [Shift] while you drag and drop. If you want to copy a file to another folder on the same drive, hold down [Ctrl] while you drag and drop.
CLASSROOM ACTIVITY
1. Quick Quiz:

1. T/F  If you delete a folder from your hard disk drive, you cannot restore the folder, but you can restore the individual files in that folder.  (F)

2. T/F  If you delete a file from a flash drive, you can restore it from the Recycle Bin.  (F)
3. T/F  To select a group of files that are adjacent, you can single-click the first item, hold down [Shift], then single-click the last item in the group. (T)
End of Unit Material
· Concepts Reviews consist of multiple choice, matching, and screen identification questions.

· Skills Reviews provide additional hands-on, step-by-step reinforcement.

· Independent Challenges are case projects requiring critical thinking and application of the unit skills. The Independent Challenges increase in difficulty, with the first one in each unit being the easiest. Independent Challenges 2 and 3 become increasingly open-ended, requiring more independent problem solving.

· Real Life Challenges are practical exercises to help students with their everyday lives by focusing on important and useful essential skills, including creating photo montages for scrapbooks and photo albums, retouching and color-correcting family photos, applying layer styles and getting Help online.

· Advanced Challenge Exercises set within the Independent Challenges provide optional steps for more advanced students.

· Visual Workshops are practical, self-graded capstone projects that require independent problem solving.

Glossary of Key Terms

· address (Windows 26)

· Address bar (Windows 26)

· backup (Windows 36)

· clipboard (Windows 36)
· cloud storage (Windows 35)

· default (Windows 28)

· drag and drop (Windows 43)

· DropBox (Windows 35)

· edit (Windows 34)

· File Explorer (Windows 26)

· file extension (Windows 28)

· file hierarchy (Windows 26)

· file management (Windows 25)

· file list (Windows 26)
· layouts (Windows 32)

· library (Windows 38)
· Microsoft SkyDrive (Windows 35)

· move (Windows 38)

· navigate up (Windows 26)

· navigate down (Windows 26)

· Navigation pane (Windows 26)

· pane (Windows 26)

· path (Windows 26)

· Preview Pane (Windows 32)

· random access memory (RAM) (Windows 28)

· Rich Text Format (Windows 28)

· search criteria (Windows 40)
· Search Tools Tab (Windows 40)

· sort (Windows 32)
· subfolder (Windows 26)

· toolbar (Windows 28)

· Windows Search (Windows 40)

· USB flash drive (Windows 28)

· View (Windows 32)

· .zip (Windows 37)
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